1. Accessing Cascade CMS

2. Your dashboard

3. Finding your office’s/department’s/program’s pages

4. Finding a folder/website’s homepage

5. Editing and creating content on a standard webpage

6. Creating and adding reusable content

7. Creating a new page/folder

8. Setting a page or folder to display in the menu navigation

9. Creating expandable dropdown options in menus

10. Resizing images before uploading to Cascade

11. Uploading images and PDFs to Cascade

12. Editing faculty and staff profile pages

13. Adding Faculty & Staff profile listings pages

14. Updating Major/Minor Requirements pages

15. What do I do if my published changes aren’t displaying?

16. Making emails hyperlinks

17. Submitting a Campus News story

18. Creating an Event Listing

19. Adding videos onto a webpage

20. Creating content (i.e., student profile pages) with photo and text in a row

21. How to color your tables

22. Changing the order of links in the menu

23. Utilizing the “Test” folder

24. Adding anchors or a “table of contents” for a webpage

A few best practices:

Need even more help?
1. Accessing Cascade CMS

https://cms.coloradocollege.edu/

a. Login and password are the same as those you use for Banner and CC’s Single Sign-In

b. We recommend using Chrome for your browser

c. Alternatively, go to the webpage you want to edit on the live CC website, scroll down, and click the underlined date next to “Last Updated.”

d. If you get an Internal Error message, that means you do not have an account in Cascade CMS. Email paraprof Nicole Leung (nleung@coloradocollege.edu) with the pages/sites you need to edit, and she will connect you with ITS to get you set up.
2. Your dashboard

a. You can customize this as you please. Your dashboard is an overview of your webpages, action items, notifications, and site content. You can add or customize widgets on your dashboard to reflect data from one or more of your sites. You can learn more about the Dashboard on the Hannon Hill Cascade Basics site: https://www.hannonhill.com/cascadecms/latest/cascade-basics/the-dashboard.html. You can always return to your dashboard by selecting the Cascade logo (tilde over the letter C) in the very top, left-hand corner of the Admin Screen (backend of the website that you as a web author see).
3. Finding your office’s/department’s/program’s pages

a. Click “SITE: Go to a Site”:

b. Click folder “CC-WWW-Production”:

c. CC-WWW-Production will open to many folders, which are sections of URLs. Follow a webpage’s URL path (each section of the URL divided by backslashes) on the live site to find a page’s location in Cascade. Each word between backslashes is the name of a folder (besides the last section of the URL, which is the page name). Most folders are organized alphabetically.

   o Example: https://www.coloradocollege.edu/academics/dept/asianstudies/

   = folders: academics → dept → asianstudies

d. First, click the “academics” folder, then click the “dept” folder, then when you click the “asianstudies” folder, it will expand to show you the subpages and subfolders (folders/pages within any folder) within the general /asianstudies folder. When you hover over a folder name, you can click the right arrow/carrot that appears (see below) to bring you to see all the folders, pages, and content saved in that folder:
e. All the Asian Studies* pages are within the /asianstudies* folder, aka website. Edit any page by double-clicking its name. *insert any department/office/program name

f. **How to quickly find pages in Cascade pro-tip**: Browse the live site and click the “Last updated: 1/11/2021” link at the bottom right-hand side of any webpage (See #1 on Accessing Cascade CMS)
4. Finding a folder/website’s homepage

a. The “index” page is the homepage of any folder. The index inside your main folder, i.e., /asianstudies, will be your site’s homepage. The index page within any subfolder will be the “home base” of that folder, so you want to have an index page in every folder; otherwise, you may be directed to a 404 Error while navigating in an index-less folder.

b. You will not always see index.html at the end of a URL on the live site. When you see a URL that ends in “/”, i.e., https://www.coloradocollege.edu/academics/dept/asianstudies/, you know you are really being taken to: https://www.coloradocollege.edu/academics/dept/asianstudies/index.html. Those URLs direct to the same place, the Asian Studies (/asianstudies/) homepage:
5. Editing and creating content on a standard webpage

a. Click on the page name in the folder that you want to edit (in the screenshot below, we clicked the “index” page within “asianstudies”).

b. Now in editing view of this page, select “Edit” (top, center):

![Editing View](image)

A popup will appear with all the settings and content container options for your page. This is where you will “build” your webpage. First, the “Display Name” will be the page title (the words between the two black horizontal lines, as seen above). Second, you must set a date for the “Review Date” field, at which date and time, you’ll be sent a reminder to review this content. Next, are page settings that offer options for menu configurations, banner images, and a sidebar option. Below that, if you scroll towards the bottom of the popup, you’ll see the outline for organizing content containers on your page:

i. **Sidebar Content** – Reusable Blocks

   Content in sidebars are reusable blocks *(see #6)*. To create or edit content here, you must edit its Reusable Content Block in the folder it’s stored; to be reminded where these are stored, click on the URL below the block:

   ![Sidebar Content](image)
As we see above, this content is stored in the “/_sharedcontent/” folder, so we want to navigate to that folder and find the content “asian-studies-sidebar-box” (last part of the URL) to edit that content that is already in the sidebar:

- To add more content to the sidebar that has already been created, click the green plus sign (+) below “Reusable Content.”
- To add new content to the sidebar, navigate to the “/_sharedcontent folder” in your department/office/program folder, create a “Reusable Block” content type, and save it there (detailed instructions in #6 of this PDF.) Then, go back to the page’s sidebar and search for the block you just created.
- To remove a content block, select the encircled “x” to the right of the block title. Clicking this “x” will not delete this content from Cascade entirely; it will only remove it from the sidebar.
- To edit content block, right-click (control + click on Mac) the block and select “edit.”

ii. **Intro Text** – brief introduction to your site or the content on your page.

iii. **Content Containers** – contain all content on your pages.

- **Content Type** drop-down contains the following options, examples of which can be view on the Content Types page of the Web Author Community website:

  [https://www.coloradocollege.edu/other/wac/using-cascade/content-types.html](https://www.coloradocollege.edu/other/wac/using-cascade/content-types.html)
  
  - Standard Web Page Content
  - Accordion
  - Buttons
  - Image Cards
  - Card Deck
  - Event Listing
  - Form Embed
  - Image Cards
• News Listing
• Photo Gallery
• Profile Listing
• Selected News Story
• Show/Hide
• Side-by-Side Text Content

- For Standard Web Page Content (what most content on CC’s website is), the “Heading” field will display as a striped section header, previously known as the “CC – Striped Section Header” in dotCMS. The “Content” will be the standard webpage text. Ignore the “Advanced Page Properties” box unless you have metadata to insert.

- Break up different sections of text into different containers. To add content containers to your page, select the green plus sign (+) in the top, right-hand corner of your container.

The best way for researchers to make sure they have enough time to go through the application, receive approval, and still have time to do research is to do an exemplary job of filling out the application and to send the proposal in as early as possible.

Treat initial contact with the IRB chair in a formal and professional manner, as you would the cover letter you sent along with a job application. Sending an extremely casual or informal email to the IRB chair signals that you may be equally casual about your obligations to the participants in your study. Unless you know the chair personally, please do not begin your email “Hey, Amanda” or in other equally informal ways.

**EXEMPTION AND APPLICATION FORMS**

If your project is a personal interest project and it is not for a grade, a course, or a thesis, and is not intended to contribute to generalizable academic knowledge, your project does not require interaction with the IRB at all, so it does not count as research by the federal government. As noted before, some Venture Grants requires IRB interaction.

If you believe that your project falls into one of the below categories, save a copy of the relevant form, fill it out, and email it to the IRB chair.

- Projects Not Defined as Research: Your project may fall into a category of research that the federal government does not define as research and that therefore does not require you to fill out an IRB proposal.

Once you have added all your content, select “Preview Draft” in the blue box in the upper right-hand corner. This will give you a preview of your page before it goes live; select “Submit” again to see how your page will look or “Check Content & Submit” to review spelling, broken links, and accessibility. You will be prompted to add an optional comment on the changes you made. Adding your own comments is helpful if you think you’ll ever need to access a previous version of the page.

To make your updates go live, select “Publish” (with a check-marked cloud beside it to the right of “Edit”).
6. Creating and adding reusable content

a. Once in your folder, select the right carrot/arrow that appears when you hover over the “_sharedcontent” folder. If you do not have this folder, create it titled just as this (see more on creating new folders in #7 below).

b. Click the pink-encircled-plus-sign “Add Content” button and choose “Reusable Content Block.” Fill out all necessary fields. For “Title,” list a short, yet informative description: i.e., “chemistry-contact-box.” Choosing a content type will give you specific fields for the type of content.

c. When complete, select “Preview Draft” and the “Submit” in upper right-hand corner. You won’t be able to see how the reusable content looks until you put it on a webpage, no worries. This container may now be added to multiple webpages in the body of the page and in sidebars.

d. When editing a Reusable Content Block in a “_sharedcontent” folder, those edits will appear on every page that the container is set to show. Remember that to push all updates live, you must select “Publish” (with a check-marked cloud to the right of “Edit”).

e. How to add a reusable content container to a sidebar:
   In the “Sidebar Contents” portion of your webpage, select the “Choose Block” button, then select “Browse” and search for the Reusable Content Block you created. Once you find it, select its radio button, then click “Choose.” To add another reusable block to your sidebar, repeat the process after selecting the green plus sign (+).

1. **Note about sidebars** Sidebar take up the entire right side of the page, even if the sidebar content doesn’t extend all the way to the bottom. In other words, you might have a large column of empty space on the right side. This sometimes create some strange alignment and compression issues, especially with photos.

f. How to add a reusable content container to a webpage’s main body:
   i. You must create the Reusable Content Block in _sharedcontent BEFORE adding it to the webpage.
ii. In the “Content Container” section, under “Content Type,” choose “Reusable Content.”

iii. When a “Choose Block” button appears, select “Browse.”

iv. Search for the Reusable Content Block you created. Once you find it, select its radio button, then click “Choose.” To add another reusable block to your sidebar, repeat the process after selecting the green plus sign (+) in the upper right-hand corner of the Content Container.

This is how you’ll you can add a reusable content block to any webpage. To edit the content container itself once it’s on a webpage, you may right-click (two-finger click on Mac) the block, then select “edit” from the drop-down. This will take you directly to the “_sharedcontent” folder where the reusable content block is stored. Be mindful that any changes made to the block will reflect on every page that the reusable content block appears.
7. Creating a new page/folder

Go to the folder in Cascade where you’d like your new folder or page.

a. New page (sub-page)
   
   i. Select “Add Content” at top (pink encircled plus sign), then select “CC Web Page.”
   
   ii. Add a “Page Name,” which will be its portion of the URL, so it must be formatted with lowercase only, word spaces replaced with hyphens, and no leading and trailing spaces.
   
   iii. “Placement Folder” will have already been selected, as this dictates the page’s location.
   
   iv. Set a “Review Date,” on which Cascade will remind you to review the content.
   
   v. The “Display Name” will be the text that appears on the webpage.
   
   vi. Make this page show on your menu by selecting yes or no.
   
   vii. The remaining options under “CC Standard Page” are the same options you get when updating content for a CC Standard Content container (see #5 on editing Standard Webpage Content).

b. New folder (sub-folder)
   
   i. Select “Add Content” at top (pink encircled plus sign), then select “Folder.”
   
   ii. Add a “Folder Name,” which will be a portion of the URL, so it must be formatted with all lowercase, word spaces replaced with hyphens, and no leading and trailing spaces.
   
   iii. “Placement Folder” will have already been selected, as this dictates the folder’s location.
   
   iv. Set a “Review Date,” on which Cascade will remind you to review the content.
   
   v. The “Title” will be the text that appears in the menu.
   
   vi. You may then opt “yes” or “no” to display your folder in the menu. Note that must have at least one other page (hopefully at least the index) within the folder also set to show on menu. This creates a menu drop-down.
   
   vii. Select “Submit” and opt to check for errors.
   
   viii. Select “Publish” to make folder appear live.

c. Drafts (works-in-progress)
i. For any folder or page that you’re working on that you don’t want to go live yet, you can
deselect/uncheck “Include when publishing.”

ii. Once you’re ready to publish, you’ll need to check this box again. Don’t worry if you forget, Cascade will
give you an error message letting you know this asset isn’t set to publish.

iii. If you unpublish a folder or page, make sure to uncheck this box so it doesn’t get republished overnight
when the CC site goes through its daily site-wide update.
8. Setting a page or folder to display in the menu navigation

a. To make a folder and its subpages in your office/department/program’s folder show on the menu:
   i. Hover over the folder you would like to show on the menu.
   ii. When “View Folder” appears, select it. You are now in folder view.
   iii. Here, select “Edit” in the top center.
   iv. In the popup, opt “Yes” for “Include this folder in menu.” The “Title” field in this popup is the label for this folder that will appear in the menu. **Note that your folder will not appear in the menu unless at least one page in your folder (hopefully at least the index) is also set to show on menu.**

![Folder settings interface]

   - **Check Spelling**
   - Include this folder in menu
     - Yes
     - No
   - Title
     - This text will appear in the menu if this folder is set to show on menu
     - Ensembles

v. In the folder contents’ view, select the page within this folder you would like to show in the menu (these pages will appear as drop-downs in your navigation).

vi. Select “Edit,” and in the popup, opt “Yes” for “Include this page in the menu.” Select “Preview Draft,” then “Submit.” Repeat this step for each page you would like to appear as a drop-down under your folder title.

vii. To adjust the order of subpages and folders as they appear on the live site, go back to the folder view in Cascade.

viii. Select “Order” to make the pages sort from smallest to largest. You can click and drag the contents in your folder into the order you please, or you can use the arrows that appear.

ix. To review what contents are currently set to appear on your menu, you may select the index page of your folder and see your menu. Changes are automatically saved but be sure to preview the menu before publishing.
x. After you have made all changes, such as moving/renaming, deleting, adding and re-ordering, you must **publish** the entire department/office/program folder by clicking the small arrow that says “view folder” next to its title and publish that to push your changes live.

b. **To make a single page in your office/department/program’s folder show on the menu:**
   i. Click the page you would like to show on the menu. You are now in page view. Here, select “Edit” in the top center. In the popup, opt “Yes” for “Include this folder in menu.”
   ii. Select “Preview Draft,” then “Submit.” Repeat this step for each page you would like to appear as a menu option in your office/department/program’s folder.
   iii. To see the changes on the entire site, you’ll need to publish the entire department/office/program folder by clicking the small arrow that says, “view folder” and select “publish.”

c. **To add a link to the menu for a page that exists outside of your office/department/program’s folder:**
   i. Navigate to the folder where you’d like the menu link (main office/department/program’s folder if you’d like it to be a single link in the menu, or a sub-folder if you’d like it to be drop-down link under a folder title/label).
   ii. In folder view, select “Add Content” at the very top of your screen next to the pink encircled plus sign.
   iii. In the popup, select “External Link” in the popup sidebar.
   iv. Fill out the necessary fields.
      **Pro-tips:** “Link Name” will be its label in Cascade CMS and “Title” will be what will appear in the menu. “Link” will be the actual URL of the page to which you want the menu option to direct.**
   v. When finished, select “Preview Draft” -> “Submit” -> “Publish.” You must also publish the entire department/office/program folder by clicking the small arrow that says “view folder” next to the title and publish that.
9. Creating expandable dropdown options in menus

Folders can become expandable dropdown options in menus when you mark in the edit settings of the folder “Yes” for “Include this folder in menu”:

a. You can make pages appear under this drop-down in the menu by marking all the pages in the folder “Yes” for “Include in menu.” So, if you add a folder with a few pages inside it that you all mark to be shown in the menu, those pages will appear as options in the drop down of that folder. You may have as many dropdowns/folders in the menu as needed.
   i. For example, the “Explore Careers” folder is marked to show on menu, and it contains a sub-folder “Where to start?” that is set to show on menu, and within that “Where to start?” folder are four pages marked to “show on menu”:

b. To make menu changes go live, you must publish your entire folder.

How to add a link to a PDF in a menu

a. Upload the PDFs into Cascade (typically, web authors store their PDFs in a _sharedcontent folder in their subsite)
b. Open the folder in Cascade where you want the PDF to be linked and select “Add Content.” In the sidebar pop out, select “external link”:

c. For the link URL, you will add the URL of the pdf saved in the CMS, i.e., in the _sharedcontent folder. You can get this URL by clicking on the PDF stored in Cascade, selecting the three dots to show more options, then selecting the bottom option, “Live”:
10. Resizing images before uploading to Cascade

Excluding background/banner photos, it’s best to resize photos to smaller than 800 pixels (width) by 800 pixels (height) before uploading. If your page has photos that have been uploaded to Cascade at a large pixel size (e.g., 2000px by 3000px), your webpage will load slowly because of the photo size. Even though you may have set the photo to display at a smaller size, the page will still load the original file size.


**Default photo editing software:**

a. **On a Mac:**
   i. Open the image in "Preview"
   ii. Rename the file to describe it (i.e., “JohnDoeHeadshot2020.jpg), and export it as a JPG if it’s not already a JPG
   iii. Click the "Tools" Menu and then click "Adjust Size..."
   iv. In the "Image dimensions" dialog box that appears, type in the desired width in pixels (<800px), or percentage, which will then adjust the height to scale proportionately. Make sure that "Scale proportionally" is checked
   v. Click OK and save your image
   vi. THEN, upload it into an images folder in Cascade ([see #11 below](#))

b. **On a PC:**
   i. Open the photo in "Paint"
   ii. Click the "Resize" button in the "Home" tab
   iii. In the "Resize and Skew" dialog box that appears, adjust the size in percentages or pixels. Make sure "Maintain aspect ratio" is checked
   iv. Click OK, then “Save As.” Rename the file to describe it (i.e., “JohnDoeHeadshot2020.jpg) and select “JPG” to save your image as a JPG file
   v. THEN, upload it into an images folder in Cascade ([see #11 below](#))

c. **In Cascade:**
   i. Find and open the photo in your “images” folder and click on “Edit.” Alternatively, find where the photo is inserted on a webpage and right-click/two-finger-click and click on “Edit” in the drop-down menu that shows up
   ii. In this edit menu, you can resize, crop, and rotate your image. Make sure to have ratio/proportions locked so your image doesn’t get stretched out.
   iii. Submit and publish your changes. You’ll also have to publish your whole folder, or at least the page(s) where this image shows up.
   iv. Editing images in Cascade is a little problematic as changes can sometimes not register even though you’ve followed all the necessary steps. It is best to make these resizing edits outside of Cascade before uploading your image(s) into Cascade to avoid any issues.
11. Uploading images and PDFs to Cascade

The most common issue with uploading any kind of file into Cascade is the naming convention. When naming your documents, use only lowercase letters, numbers, and hyphens or underscores. Avoid capital letters, spaces, and special characters.

a. Option 1:
   i. Navigate to the “images” or “docs” folder of your department/office/program folder. If you do not have “images” and “docs” folders, create them (see #7 above). In folder view, select the pink-encircled-plus-sign “Add Content” button, then select “File” in the popup.
   
   ii. **Double-check** “File Name” and “Placement Folder” to make sure that the file is going to the right place and the name is what you want it to be. “Title.”

   iii. Drag and drop or choose from your computer the files (JPGs or PDFs) you want to put on your website. You will put **ALL** images and documents that will be used on your department/office/program’s subsite in these folders. Select “Preview Draft,” then “Submit,” then “Publish.”

   iv. To add these to a webpage, navigate to the page on which you want the image/document in Cascade, select “Edit,” find the container you want it in, then select:
      
      a. For a document, “insert/edit link” (chain icon), then check “Internal,” then “Choose file,” and search for the document in your documents folder

      b. For an image, “Insert/edit image” -> “Internal” -> “Choose file” and search for the image file in your images folder.

      c. Select “Preview Draft” -> “Submit” -> “Publish.”

b. Option 2:

   i. Navigate to the container on a page where you want the image or document.

   ii. For an image, select “insert/edit image.” In the popup, select “Internal” -> “Choose file” -> “Upload,” and choose the image from your computer.

   iii. For a document, type the title of your document, then highlight the text and select “insert/edit link” (chain icon). In the popup, select “Internal” - > “Choose file” -> “Upload,” and choose the document from your computer.

   iv. Select “Preview Draft” -> “Submit” -> “Publish” to push changes live.
12. Editing faculty and staff profile pages

a. **Option 1** – if your page references the Directory site/if the URL of your profile contains “/basics/contact/directory/”.
   i. Select “Directory” for “Site” in the top left-hand corner of Cascade (the other option besides WWW-CC-Production).
   
   ii. Select the “people” folder. Here, you can search for all CC names. To edit a profile, select the name, then select “Edit.” *Fields with the description “From Banner” require contacting HR as any changes you make in these fields in Cascade will be overwritten by Banner the next day (even if the field was blank).*
   
   iii. Select a department in “Department,” i.e., “Chemistry,” for them to show on that department’s profile listings page. Select “Submit.”
   
   iv. To view changes, scroll down to your department’s name within the Directory folder, select it, and publish.

b. **Option 2** – if your page lives in your department’s/office’s folder on the cc-www-production site/has a URL does NOT include “/basics/contact/directory/”.
   i. Go to the profile page you want to edit on the live CC website and access Cascade through the “Last Updated” link *(See #1 above on Accessing Cascade CMS)*.
   
   ii. Click “Edit” in the top right and open the Profile Listings content container. You can only add/remove people and rearrange the order of the profiles *(See #13 below for more detailed info on Adding Faculty & Staff profile listings page)*.
   
   iii. To edit a specific profile, right-click (PC) or two-finger click (Mac) to open a mini menu and click “Edit.” This opens the menu that allows you to make detailed edits. Like with Option A above, some edits, particularly the ones that live in the Metadata tab, will require contacting HR to update that person’s profile in Banner.
iv. “Preview Draft” will bring you to that person’s page in the Directory site, from here you can submit and publish your changes.

v. You’ll need to go back to the profile page in the cc-www-production site and publish from there to see the changes you made to the person’s profile on the live site.

<table>
<thead>
<tr>
<th>Name</th>
<th>Anne</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Name *</td>
<td>Schanz</td>
</tr>
<tr>
<td>Position Title</td>
<td>Assistant Professor</td>
</tr>
<tr>
<td>Phone</td>
<td>(719) 389-6513</td>
</tr>
<tr>
<td>Email</td>
<td><a href="mailto:sschanz@coloradocollege.edu">sschanz@coloradocollege.edu</a></td>
</tr>
<tr>
<td>Office</td>
<td>Palmer Hall, #9C</td>
</tr>
<tr>
<td>Category</td>
<td>faculty</td>
</tr>
<tr>
<td>Status</td>
<td>Faculty - Full Time</td>
</tr>
</tbody>
</table>
13. Adding Faculty & Staff profile listings pages

a. Go to the folder in Cascade where you’d like your profile listings page.

b. Select “Add Content” at top (pink encircled plus sign), then select “CC Web Page.”

c. Add a “Page Name,” which will be its portion of the URL, so it must be formatted with lowercase only, word spaces replaced with hyphens, and no leading and trailing spaces.

i. “Placement Folder” will have already been selected, as this dictates the page’s location.

ii. Set a “Review Date,” on which Cascade will remind you to review the content.

iii. Make this page show on your menu by selecting yes or no.

iv. In the first Content Container, select “Profile Listing” for content type.

v. Select the first block “Choose Page” and search for staff member.

vi. To add more, select the green plus sign “Add new field” (+) and search for each staff member. To remove, select the red X sign “Remove” (X).

vii. Use the up and down arrows to manually arrange

viii. Select Preview Draft -> Submit -> Publish to make your changes go live.
14. Updating Major/Minor Requirements pages

Updates are made once a year during the spring catalog update window. Please reach out directly to the Registrar’s Office if changes must be made outside that window. For more information about the Catalog of Courses, visit https://www.coloradocollege.edu/offices/registrar/faculty-information/ and scroll to the bottom of the page.

If you have major/minor requirements page that lives in Cascade and doesn’t link to the Registrar’s Catalog of Courses, you can edit the content like you would any other webpage in Cascade.
15. What do I do if my published changes aren’t displaying?

Clear your web browser cache. Select “Chrome,” then “Clear Browsing Data…” (below) then select “Cached images and files” in the popup.

If you made changes to shared content (i.e., sidebars), you would need to publish the entire folder for the changes to show up. For example, if you made changes to the Art department contact info box that appears on other Art department pages, you’ll need to publish the entire Art department folder on Cascade CMS for the changes to take hold.
16. Making emails hyperlinks

a. Highlight the email address you want to make a link, i.e., “example@coloradocollege.edu”

b. Click the link symbol and directly click through the popup (hit only “Ok”). Cascade will detect that the text is an email address and automatically make it a link.

c. To double-check that the email has the correct hyperlink, publish the page, go to the live CC site, and hover over the hyperlinked email to see where it redirects (look at bottom left corner of your screen, the desired email should be preceded by “mailto:”)
17. Submitting a Campus News story

a. To submit a news story, go to your Cascade CMS user dashboard

b. Select CC-WWW-Production for site

c. Next, select “Add Content” just to the right of CC-WWW-Production

d. Select “Campus News” from the pop-out and fill out your news story
a. To make the Campus News story appear on your department/office/program’s website, select your department/office/program for “Office” when in editing mode of your Campus News Story.
18. Creating an Event Listing

(NOTE: initial event creation is done through Ungerboeck, not Cascade CMS)

Complete instructions for event creation are found here:
https://www.coloradocollege.edu/other/wornerdesk/resources/Event-Guide.pdf

a. Create the event/reserve the space through Events Management on the Single Sign-in page.

b. Afterwards, you can add the event through the “Event Listing” content type in your content container. Fill out the appropriate tags in the dropdowns and Cascade will pull those events from Ungerboeck.

c. Typically, you will only need to fill out EITHER “Academic Department” or “Office.”

d. **Only upcoming events will show up.** Past events will automatically disappear from the event feed. If you want to maintain a particularly important past event on your webpage, create a news story or give it its own page.
Content Container

Content Type
Event Listing

Heading

Event Listing

Display Subheader
Music Department Calendar of Event:

Academic Department
Music

Office
Select one or more values...

Event Type
e.g., Reading, Concert, Panel, etc.
Select one or more values...

Audience

Including a tag will override event listing settings above.

Custom Filter
For advanced filtering. Using this will override any event listing settings above.

Max. entries *
Maximum number of entries to display
12

Show type
e.g., Reading, Concert, Panel, etc.
Yes

Only show public events
Only display events which are open to the general public
Yes

Cache Duration
How frequently should this feed be pulled from its source, in seconds (1800 = 30 minutes)
1800
19. Adding videos onto a webpage

(Note: Your videos must be uploaded to a video hosting site (i.e., YouTube, Vimeo, Prezi) BEFORE proceeding with these steps)

a. Create your webpage and choose your desired content type. You can add videos using any content type with a WYSIWYG tool bar (i.e., side-by-side content, card deck, standard webpage content); however, using the “Video” content type is the easiest.

b. If you’d like, add a heading. This will appear as an all-caps striped section heading (see #5 above)

c. If using the WYSIWYG tool bar to add your video, select the “Insert/edit media” button

d. The popup menu gives you the option to either paste in the URL (the “Source” field in the “General” tab) or the embed code (“Embed” tab) of the video. You only need to put in information in one of the tabs.

e. If you’re using the “Video” content type, your video(s) fill out the desired fields. CC videos typically have the title or heading, video thumbnail, and associated text (is basically a caption but you get more control over it than the actual “Caption” field) fields filled out.

f. The video thumbnail is typically just a screenshot of the video at some point. If you do not put a thumbnail, the video will show up on the webpage as a black/gray box with the play button in the center.

g. The “Video” content type only supports YouTube and Vimeo URLs, if your video is on a different platform, such as Prezi Video, you’ll need to use a content type like “standard webpage content.”
20. Creating content (i.e., student profile pages) with photo and text in a row

a. Create your webpage (or open the webpage to where you want this content. In editing mode, in the first content container where it says: “Standard Web Page Content,” open the drop-down and select “Side-by-side text content.”

b. Add a heading if you choose (this will appear as an all-caps striped section heading).

c. Select “1/3 left – 2/3 right” for “Side-by-side style”

d. In the “Left Container,” select the image icon or “Insert” > “Image.” In the popup, select “Choose File,” then drag/drop (or “Choose” then select) the image from your computer (or wherever it is).

e. In the “Right Container,” add your text.
f. To add section headings, add “Heading” in only the top content of that section. For example, on this page I would only add the “Class of…” headings on the top profile:

```
CLASS OF 2025 SCHOLARS
```

Hello, my name is Aidan Braly! I also go by Aiko, which is the Japanese nickname that my family uses for me. I was born and raised in Denver, CO, and am excited to explore a new part of Colorado. I'm very passionate about social/political issues and have recently become much more involved in the Denver AAPI community. I founded the Asian Pacific Islander student alliance at my high school and am very excited to get involved in the Asian Student Union at CU. I've also played violin since third grade and plan to restart formal lessons and possibly get involved with other music groups on campus. I'm very honored to have been selected for this scholarship and am excited to begin my journey with The Whel!

```
g. It is highly recommended that you turn on descriptions for content containers when making numerous rows of “side-by-side” content. The option is located at the bottom of the “Edit” box.
```

Advanced Page Properties

Insert into page <head>

Anything added here will be inserted into the <head> of the page (was called Page Metadata in dotcms)

---

Cascade View Options

Show Descriptions for Content Containers

- [ ] Yes
- [ ] No

Tags

Select one or more values...
21. How to color your tables

You’re able to format the background colors of the table rows and cells in the WYSIWYG content container editor.

If you’re not sure of what color to use, the Visual Identity Guidelines put out by Communications is a great place to start and to make sure you’re still in the CC brand. In this case, you’ll be using the Color Palette Swatches document.

a. Select “Table” from the toolbar drop-down

b. Click “Cell,” then “Cell Properties” (or “Row” -> “Row Properties” depending on what you want colored)

c. In the popup, you’ll want to select the “Advanced” tab where you can add colors using RGB color codes:
For example, here are the color codes in reference to the below screenshot:

- **Gold** (as used in the headings): #ffcc00
- **Grey** (as used in BLOCK 7): #a9a9a9
- **Light grey** (as used for some Armstrong West): #e5e5e5
- **White** (as used for some Armstrong West): #ffffff
- **Light gold** (as used for South): #ffe890

<table>
<thead>
<tr>
<th>DAY/DATE</th>
<th>TIME</th>
<th>FIELD</th>
<th>TEAMS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Thu 4/1</strong></td>
<td></td>
<td><strong>BLOCK 7</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3:30</td>
<td>Armstrong West</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4:30</td>
<td>Armstrong West</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5:30</td>
<td>Armstrong West</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3:30</td>
<td>South</td>
<td>The Cornballers vs. South Students</td>
</tr>
<tr>
<td></td>
<td>4:45</td>
<td>South</td>
<td>Las Chanclas FC vs. Get Mags, Break Legs, Drink Kegs</td>
</tr>
<tr>
<td></td>
<td>3:30</td>
<td>Tava Quad</td>
<td>STEPBROS vs. Fowl Play</td>
</tr>
<tr>
<td></td>
<td>4:45</td>
<td>Tava Quad</td>
<td>Meg-Ladons vs. Mud's Ballz</td>
</tr>
<tr>
<td><strong>Tue 4/6</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3:30</td>
<td>Armstrong West</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4:30</td>
<td>Armstrong West</td>
<td></td>
</tr>
<tr>
<td></td>
<td>5:30</td>
<td>Armstrong West</td>
<td></td>
</tr>
<tr>
<td></td>
<td>3:30</td>
<td>South</td>
<td>Jimmy John's Foot Longs vs. Raw Beef</td>
</tr>
<tr>
<td></td>
<td>4:45</td>
<td>South</td>
<td>Las Chanclas FC vs. Fowl Play</td>
</tr>
<tr>
<td></td>
<td>3:30</td>
<td>Tava Quad</td>
<td>Cornballers vs. Mud's Ballz</td>
</tr>
<tr>
<td></td>
<td>4:45</td>
<td>Tava Quad</td>
<td>Get Mags, Break Legs, Drink Kegs vs. 11 Positions in 90 Minutes</td>
</tr>
</tbody>
</table>
22. Changing the order of links in the menu

Links in the main navigation menu and the drop-down menus appear in order of creation: most recently created links/folders/pages will appear on the left (navigation) or on top (drop-down).

a. Open the folder where your menu items live. You’ll need to open the folder in the large folder view by clicking on the arrow “>” next to the folder name in the left sidebar.

b. Arrange your folder items by clicking Order so that items are now listed in numerical order starting from 1.

c. Click on the box next to the item you want to move. You can only move items one at a time. Make sure to uncheck the box when moving the next item.

d. A set of up and down arrows will appear after checking a box. Use these arrows to change the order of the items. I recommend moving all the items that aren’t set to show in the menu to the bottom to reduce confusion among the items that do show up on the navigation or drop-down menu.

e. Alternatively, you can click and drag the item and rearrange the order that way.

f. Once the folder items are ordered the way you want, publish the whole site’s folder to make these changes appear on the live website. Menu changes sometimes take a little while to show up. Publishing the homepage/index of that site can help make those changes appear if it’s taking a long time for your menu changes to take effect.
23. Utilizing the “Test” folder

For bigger website projects that will take some experimentation and time to complete (as opposed to basic content updates), you might want to build your page(s) in the “test” folder in Cascade. There is also an example site with most all the formatting options in Cascade and UNICODE for your reference.

“Test” folder

a. Navigate to CC-WWW-Production -> test.

b. Create a folder for yourself that you can find easily. Go ahead and make your test pages and try whatever you want. The “test” folder’s subfolders and pages are not viewable by someone on the live site unless they have a specific link to a published page.

c. You can copy/move a page or folder from this “test” folder to your main folder once you’re happy with the setup.

Example site

a. Navigate to CC-WWW-Production -> test -> example ->index

b. This site is also viewable on the live CC site. [https://www.coloradocollege.edu/test/example/index.html](https://www.coloradocollege.edu/test/example/index.html)

Making your own test folder

a. You can also make a folder to experiment on within your department’s/office’s folder if you’re comfortable on changing the publishing settings ([see #7 for help on creating new folders and pages](#7)).

b. Label your test page or folder so you know that it’s a work-in-progress and not for putting on the live site.

c. Putting in comments when submitting your changes will also help you keep track of the different iterations on your test pages and folders.
24. Adding anchors or a “table of contents” for a webpage

Anchors allow you to create a table of contents for a single, long webpage or for creating hyperlinks that reference specific parts within in the same page.

a. Decide where you want to have your table of contents and how you would like to format it. You can format this the same way you format regular paragraph text. We will be essentially adding a hyperlink.

b. Navigate to the place on this webpage where you want to “bookmark” for quick reference (i.e., heading section, certain paragraph, a person’s profile).

c. Click on the “anchor” icon – it looks like a banner or bookmark – and give this an ID. Try to keep this short, ideally one word, but specific (i.e., intro, nicole, block3).

i. Notice that I don’t capitalize or use spaces or special characters. This is my way of keeping the IDs as simple as possible to prevent typos. These IDs act like URLs that you can link to. They will appear as a little ship anchor in a box. They will not affect formatting and spacing on the live site like they do in this “Edit” view.
d. Go back to your table of contents/page navigation area. Select the text you want to highlight/make clickable and click on “insert/edit link” (chain icon) in your toolbar.

e. In the field labeled “Anchor,” input the associated ID (copy and paste is my favorite method). Continue for all the other titles in your table of contents/clickable navigation. If you’ve ever used an online version of book (they often come with a clickable table of contents) this is the same idea.

f. Once you click “Ok” out of that pop-up menu, your text should look exactly like a hyperlink. You won’t be able to text out the link in this “Edit” window and will need to “Preview Draft” so you can test the links. Broken links with anchors DO NOT display a 404 error page; they just simply don’t do anything when clicked on.

   i. Remember to test out the links on the live site. You might need to adjust the placement of the anchor.
A few best practices:

- Do not underline text. Because links are automatically underlined, anything that is not a link should not be underlined.
- Do not title links “click here.” Safe links are specific.
- Resize photos before uploading to Cascade. Make sure photos are under 800 pixels by 800 pixels unless they are banner/hero images (1920 x 725px).
- Do not override major style defaults with HTML/CSS (e.g., page background color, font color).

Need even more help?

There is also a wealth of information available on the Cascade CMS Knowledge Base: https://www.hannonhill.com/cascadecms/latest/.

Any further Cascade questions should be directed to Nicole Leung, Karen To, or Mark Lee (Spencer Center, 4th floor)

Nicole Leung  
Web Communications Paraprofessional  
719-389-6139  
nleung@coloradocollege.edu

Karen To  
Director of Web & Digital Media  
719-389-6144  
kto@coloradocollege.edu

Mark Lee  
Director of Web & Digital Media  
719-389-6030  
mlee@coloradocollege.edu